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1 Introduction

As part of our investigation of the vulnerability of the major and minor aquifers of Texas to
subsidence with regard to groundwater pumping, we developed a tool to provide a
screening-level analysis of subsidence potential. For ease of use by potential users, we
developed the tool using Microsoft Excel 2016 (Version 1802, Build 9029.2167 Click-to-
Run). The tool estimates land-surface subsidence, using the general expression for
compaction or expansion of aquifer sediments based on user input and typical values for
various parameters.

We have prepared this guide to provide users with a quick reference for how to use the
subsidence prediction tool. For a more detailed discussion of the calculations performed by
the tool, we refer the user to Section 6 of the final project report.

1.1 Subsidence Prediction Tool File Description

We saved the original file as an Excel Binary Workbook (*.xIsb file extension). Some
calculations in the workbook use custom functions written in Visual Basic for Applications
(VBA). In addition, the tool populates some variables using macros. To effectively use the
tool, users will need to allow macros to run within the application. To enable macros in
Excel, click Developer > Macro Security and select the Enable all macros button. If the
“Developer” tab is not visible, click File > Options > Customize Ribbon and select the
Developer check box.

We applied several options to prevent accidental changes to the subsidence prediction tool.
First, we made the calculation worksheet tab invisible. To view the tab, click File > Options
> Advanced and under Display options for this workbook select the Show sheet tabs
check box.

We also set password protection on the worksheets and VBA project. The password for all
items in the application is Water4Texas. To unprotect a worksheet, click Review >
Unprotect Sheet and enter the password. Alternatively, users can unprotect all of the
worksheets at one time by clicking Developer > Macros, selecting
ThisWorkbook.unProtectSheets, then clicking Run (see Figure 1.1). Listed in the Macro
dialog box are a total of four macros that perform the following functions:

o ThisWorkbook.hideReferenceSheets hides all the worksheets in the tool except for
the sheet on which the calculations are performed.

e ThisWorkbook.protectSheets applies password protection to all worksheets in the
workbook.

e ThisWorkbook.unhideReferenceSheets makes all the worksheets visible to the user.

e ThisWorkbook.unprotectSheets removes protection from all worksheets in the
workbook.
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Macro ? >
Macro name:
Thisworkbook.unProtectSheets + Eun
ThisWorkbook.hideReferenceSheets
ThisWorkbook.protectSheets Step Into
ThisWorkbaook.unhideReferenceSheets
ThisWorkbook. unProtectsheets Edit
Create
Delete
Options...
Macros in: | All Open Workbooks w
Description
Cancel

Figure 1.1. Microsoft Excel macro dialog box.

As stated above, we applied the protection to prevent accidental changes to the subsidence
prediction tool. However, the user will need to unprotect the worksheet to make
intentional changes, such as formatting the charts created by the tool (the charts are
described in Section 2). For example, to adjust the scale of the axis on the charts, the user
should run the macro for unprotecting the sheets, make the desired changes, then run the
macro to protect the sheets.

We set the subsidence prediction tool to populate with default or suggested values each
time the user opens the workbook. Upon opening the workbook, the tool will set the
Aquifer to General Calculation, the Well Name to Well, and the Water Levels to Use for
Predictions to Current and Trend (see Figure 1.2). Upon setting these initial values, the tool
clears several of the User Input Values and recalculates the predicted water levels.
However, if a user wishes to save a workbook with the entries for a particular well, the user
should uncheck the box next to Reset Subsidence Prediction Tool on Open.

Aquifer General Calculation o Reset Subsidence
Report Generated by USER lzilelen Todl el Ziel
Report Date 03/13/2018

Well Name Well

Water Levels to Use for Predictions Current and Trend

Figure 1.2. General information input section from the subsidence prediction tool.
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1.2 Subsidence Prediction Tool Explanation

We recommend saving a copy of the workbook prior to making changes to input variables.
Light blue shading indicates manual input variables for the subsidence calculations. Orange
shading indicates calculated and other automatically populated fields. The following
provides a brief description of each input variable and its associated units:

Aquifer: A drop-down menu for each major and minor aquifer where upon selection
the aquifer properties are populated with the average values for that aquifer. Note
that this drop-down menu also contains a “General Calculation” aquifer where the
aquifer properties are left blank for the user to input the appropriate information.
Report Generated by: a “Name” field intended to contain the identity of the tool user.
Well Name: if applicable, the well identification where the user is calculating
potential subsidence.

Water Levels to Use for Predictions: A drop-down box that allows the user to base
potential subsidence predictions on the current water level and the water level
trend or the base and future water levels.

Land Surface (feet mean sea level): The surface elevation.

Aquifer Top (feet mean sea level): The elevation of the top of the aquifer.

Aquifer Thickness (feet): The aquifer thickness.

Clay Thickness (feet): Clay thickness in the aquifer.

Groundwater temperature (Degrees Celsius): The temperature of the water within
the aquifer.

Groundwater Total Dissolved Solids (TDS in milligrams per liter): The TDS value of
the groundwater within the aquifer.

Predevelopment Water Level (feet mean sea level): The water level within the
aquifer prior to any historical pumping.

Current Water Level (feet mean sea level): The current aquifer water level.
Unsaturated Thickness (feet mean sea level): Estimate of the unsaturated thickness
below land surface above the water table. For a confined aquifer, the value
represents the estimated depth from land surface to the water level in the aquifer or
formation closest to land surface.

Preconsolidation Water Level (feet mean sea level): The deepest measured water
level within the aquifer.

Base Water Level (feet mean sea level): The starting water level for subsidence
prediction. This value could be the base year desired future condition water level.
Future Water Level (feet mean sea level): The ending water level for subsidence
prediction. This value could be the ending year desired future condition water level.
Beginning Year for Subsidence Evaluation: The first year for the Water Level
Prediction chart and aquifer Drawdown and Subsidence Prediction chart.

Ending Year for Subsidence Evaluation: The final year for the Water Level Prediction
chart and aquifer Drawdown and Subsidence Prediction chart.
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Based on the above variables the tool populates the following default or suggested values
(Note: blue shaded cells may be manually changed/overwritten):

Water Level Trend (feet per year): The average water level trend for the aquifer.
Negative values indicate declining water levels and positive values indicate rising
water levels.

Predominant Aquifer Lithology: The broad lithology classification for the aquifer. A
drop-down menu provides the four available options.

Aquifer Storage Coefficient (dimensionless): The storage coefficient for the aquifer,
describing how much water is released per foot decline in aquifer water level.
Aquifer Porosity (percent): The aquifer porosity entered as a number between 0 and
100. For example, 35 percent is entered as 35 and not as 0.35.

Predominant Aquifer Clay Type: The predominant clay type within the aquifer. A
drop-down menu provides the three available options.

Aquifer Clay Porosity: The porosity of the clay within the aquifer based on the
predominant aquifer clay type entered as a number between 0 and 100. For
example, 35 percent is entered as 35 and not as 0.35.

Minimum and Maximum Aquifer Compressibility (psi-1): The minimum and
maximum values of the compressibility of the aquifer based on the predominant
aquifer lithology. The values will automatically update to typical minimum and
maximum values based on the selected Predominant Aquifer Lithology.

Minimum and Maximum Clay Compressibility (psi-1): The minimum and maximum
values of the compressibility of the clay within the aquifer based on the clay type.
The values will automatically update to typical minimum and maximum values
based on the selected Predominant Aquifer Clay Type.

Minimum and maximum aquifer elastic specific storage (foot1): The minimum and
maximum values of the elastic component of specific storage (Sske).

Minimum and maximum aquifer inelastic specific storage (foot1): The minimum and
maximum values of the inelastic component of specific storage (Sskv).

Total Weighted Risk for Well: The total weighted subsidence risk for the well
according to the input parameters.
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2 Calculating Subsidence Predictions

Upon opening the subsidence prediction tool, the user will see the information similar to
Figure 2.1 and Figure 2.2 (actual display will vary depending on screen size). As shown in
Figure 2.1, the tool opens with a General Calculation specification for the Aquifer, where
the input variables are blank and the parameters shown in Figure 2.2 are populated with
default values. The user will input values for each of the blank parameters to calculate a
Total Weighted Risk for the well. Within the tool, blue cells indicate user input
parameters, orange cells indicate calculated parameters, and gray cells indicate a drop-
down menu.

To populate the User Input Values with the average values for a specific aquifer, the user
may select the aquifer of interest from the drop-down menu (see Figure 2.3). Figure 2.4
illustrates the population of the User Input Values with the average values for the Pecos
Valley Aquifer when the user selects Pecos Valley for the Aquifer. If the user is uncertain of
the specific information for a particular well location, these default values will provide an
initial estimate of the subsidence risk which for the Pecos Valley Aquifer is 5.78 (see Figure
2.4).

The user may refine the User Input Values by entering specific information for a well
while leaving the default suggested values for unknown parameters. For example, if a user
is investigating the subsidence potential for the well completed in the Pecos Valley Aquifer
with Tracking Number 417430 in the Submitted Drillers Report database, the user could
enter the aquifer information at the well site (see Figure 2.5). The subsidence tool will use
the entered values along with the default suggested values to calculate a Total Weighted
Risk for Well of 6.72 indicating high subsidence risk at the location (see Figure 2.6).

The Total Weighted Risk for Well is one of the primary outputs for the tool. The
calculated value allows the user to quickly assess the potential risk for subsidence at the
location using a scale from 0 (lowest potential subsidence risk) to 10 (highest potential
subsidence risk). Users are referred to Section 3.4 of the final project report for a detailed
discussion regarding the calculation of the subsidence risk value.

Scrolling down the worksheet, the user will see two charts. The Water Level Prediction
chart illustrates the predicted water level, land surface elevation, preconsolidation water
level, and the aquifer top and bottom. The tool calculates the predicted water level using
the Water Levels to Use for Predictions selection. For either possible selection the tool
calculates estimates from the Beginning Year for Subsidence Evaluation. If the user
selects Current and Trend, then the tool calculates the predicted water level using the
Water Level Trend and Current Water Level; if the user selects Base and Future, then the
tool calculates the predicted water level using the Base Water Level and Future Water
Level assuming a linear trend between the Beginning Year for Subsidence Evaluation
and Ending Year for Subsidence Evaluation. The starting and ending years on the chart
are based on the Beginning Year for Subsidence Evaluation and Ending Year for
Subsidence Evaluation values. Figure 2.7 illustrates the Water Level Prediction chart for
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the well completed in the Pecos Valley Aquifer with Tracking Number 417430 described
above.

The Drawdown and Subsidence Prediction chart illustrates the change in water level per
the Water Levels to Use for Predictions selection along with the minimum and maximum
subsidence predictions based on the water level change. The tool calculates the compaction
of aquifer material based on the change in stress associated with changing water levels (see
Equation 16 in Section 6.1 of the final project report). Figure 2.8 illustrates the Drawdown
and Subsidence Prediction chart for the well completed in the Pecos Valley Aquifer with
Tracking Number 417430 described above.

As described in Section 3.4.4. of the final project report, the tool uses both options for
predicting water level changes when calculating the Total Weighted Risk for Well. Since
the tool uses both options, the risk value is not affected by the Water Levels to Use for
Predictions selection. However, the Water Level Prediction chart and Drawdown and
Subsidence Prediction chart can be affected by the user’s selection. Figure 2.9 illustrates
the Water Level Prediction chart and Figure 2.10 illustrates the Drawdown and
Subsidence Prediction chart for the well completed in the Pecos Valley Aquifer with
Tracking Number 417430 described above when the user selects Base and Future as the
Water Levels to Use for Predictions.

Below the two charts, the tool also provides a table of the water level, drawdown, and
subsidence estimates that the tool references to create the charts discussed above. Table
2.1 is an excerpt of the table in the subsidence prediction tool. The water level values are
calculated using either the Current Water Level and the Water Level Trend or the Base
Water Level and Future Water Level assuming a linear trend between the Beginning
Year for Subsidence Evaluation and Ending Year for Subsidence Evaluation. However,
users may overwrite the formulas in these cells to allow for predictions other than a simple
linear trend. Building upon the example provided previously, suppose the user wished to
show an abrupt water-level decline in 2030, followed by a continued decline of two feet per
year, and subsequent recovery of one foot per year, then the user could enter these water-
level values into the table and the tool would predict potential subsidence based on the
entries. Figure 2.11 illustrates the predicted drawdown and subsidence based on this
hypothetical scenario. To reset the predicted water levels to the calculated values, the user
simply needs to reselect the Water Levels to Use for Predictions.
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Aquifer

Report Generated by
Report Date

Well Name

Water Levels to Use for Predictions

General Calculation

Location and Water Level Based
User Input

Land Surface (feet MSL)

Aquifer Top (feet MSL)

Aquifer Thickness

Clay Thickness within Aquifer
Groundwater Temperature
Groundwater Total Dissolved Solids (TDS)

Predevelopment Water Level (feet MSL)

Current Water Level (feet MSL)

Unsaturated Thickness

Preconsolidation (deepest) Water Level (feet MSL)
Base Water Level (feet MSL)

Future Water Level (feet MSL)

Beginning Year for Subsidence Evaluation

Ending Year for Subsidence Evaluation

M. Keester
03/13/2018
Well
Current and Trend

User Input Values

2010
2070

Reset Subsidence
Prediction Tool on Open

feet

feet

feet

feet
Degrees Celsius

meg/I
feet

feet
feet
feet
feet
feet

year

year

Legend

User Input values
Calculated

Drop-down menu

Figure 2.1. Subsidence prediction tool opening page.
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Note that this sheet estimates subsidence as described in Identification of the
Vulnerability of the Major and Minor Aquifers of Texas to Subsidence with Regard to
Groundwater Pumping (TWDB Contract Number 1648302062). Estimates provided by
this tool are approximate and actual subsidence may vary significantly from the
estimates provided by this tool. In addition, time delay of subsidence is not included in
the calculation.

Aquifer Subsidence Calculations based on overall aquifer

information and user supplied input values

Total Weighted Risk for Well
0 (low risk) to 10 (high risk)

Units

Water Level Trend 0.00 ft/year; negative for decline
Predominant Aquifer Lithology Unconsolidated Clastic Description
Aquifer Storage Coefficient 0.15 Dimensionless
Aquifer Porosity 35 Percent
Predominant Aquifer Clay Type Plastic Clay Type
Aquifer Clay Porosity 50 Percent
Minimum Aquifer Compressibility 3.59E-04 psit
Maximum Aquifer Compressibility 6.89E-04 psi'1
Minimum Clay Compressibility 1.79E-03 psi'1
Maximum Clay Compressibility 1.38E-02 psi'1
Minimum Elastic Specific Storage (Sqke) i
Maximum Elastic Specific Storage (Sqke) ftt
Minimum Inelastic Specific Storage (Sey) ftt
Maximum Inelastic Specific Storage (Sq.) ftt

Figure 2.2.

Subsidence prediction tool opening page default values.
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Aquifer General Calculation _
G | Calculati

Report Generated by Blaineoen s
Elossom

REDDI"I: Date Bone Spring-Victorio Peak
Brazos River Alluvium

Well Name Capitan Reef Complex
Carrizo-Wilcox
Drackum

Figure 2.3. Subsidence prediction tool aquifer drop-down menu.
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Aquifer

Report Generated by
Report Date

Well Name

Water Levels to Use for Predictions

Location and Water Level Based
User Input

Land Surface (feet MSL)
Aquifer Top (feet MSL)
Aquifer Thickness

Clay Thickness within Aquifer
Groundwater Temperature
Groundwater Total Dissolved Solids (TDS)

Predevelopment Water Level (feet MSL)
Current Water Level (feet MSL)

Unsaturated Thickness
Preconsolidation (deepest) Water Level (feet MSL)
Base Water Level (feet MSL)

Future Water Level (feet MSL)

Beginning Year for Subsidence Evaluation

Ending Year for Subsidence Evaluation

Pecos Valley
M. Keester
03/13/2018
Well
Current and Trend

User Input Values

2,706
2,706
549
36
21
2,550
2,662
2,614
89
2,622
2,626
2,576
2010

2070

Reset Subsidence
Prediction Tool on Open

feet

feet

feet

feet
Degrees Celsius

mg/l
feet
feet
feet
feet
feet
feet

year

year

Legend

User Input values
Calculated

Drop-down menu

Figure 2.4. Subsidence prediction tool Pecos Valley Aquifer average values.
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Aquifer Subsidence Calculations based on overall aquifer y

nits
information and user supplied input values
Water Level Trend -0.27 ft/year; negative for decline
Predominant Aquifer Lithology Unconsolidated Clastic Description
Aquifer Storage Coefficient 0.15 Dimensionless
Aquifer Porosity 35 Percent
Predominant Aquifer Clay Type Plastic Clay Type
Aquifer Clay Porosity 50 Percent
Minimum Aquifer Compressibility 3.59E-04 psi
Maximum Aquifer Compressibility 6.89E-04 psi -
Minimum Clay Compressibility 1.79E-03 psi
Maximum Clay Compressibility 1.38E-02 psi -
Minimum Elastic Specific Storage (5..) 1.64E-06 i
Maximum Elastic Specific Storage (Scke) 5.60E-06 ft
Minimum Inelastic Specific Storage (S.,) 1.64E-04 ftt
Maximum Inelastic Specific Storage (S..,) 5.60E-04 ft™
Total Weighted Risk for Well 5.78

0 (low risk) to 10 (high risk) *

Figure 2.4. Subsidence prediction tool Pecos Valley Aquifer average values (continued).
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Aquifer

Report Generated by
Report Date

Well Name

Water Levels to Use for Predictions

Location and Water Level Based
User Input

Land Surface (feet MSL)
Aquifer Top (feet MSL)
Aquifer Thickness

Clay Thickness within Aquifer
Groundwater Temperature
Groundwater Total Dissolved Solids (TDS)

Predevelopment Water Level (feet MSL)
Current Water Level (feet MSL)

Unsaturated Thickness

Preconsolidation (deepest) Water Level (feet MSL)
Base Water Level (feet MSL)

Future Water Level (feet MSL)

Beginning Year for Subsidence Evaluation

Ending Year for Subsidence Evaluation

Pecos Valley
M. Keester
03/13/2018
Tracking Number 417430
Current and Trend

User Input Values

2,470
2,470
331
135
20
1,095
2,474
2,467
42
2,467
2,474
2,462
2010

2070

Reset Subsidence
Prediction Tool on Open

Units

feet

feet

feet

feet
Degrees Celsius

mg/
feet
feet
feet
feet
feet
feet

year

year

Legend
User Input values
Calculated

Drop-down menu

Figure 2.5. Subsidence prediction tool Pecos Valley Aquifer input values for Tracking Number 417430 in the
Submitted Drillers Report database.
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Aquifer Subsidence Calculations based on overall aquifer Uni

nits
information and user supplied input values
Water Level Trend -0.27 ft/year; negative for decline
Predominant Aquifer Lithology Unconsolidated Clastic Description
Aquifer Storage Coefficient 0.15 Dimensionless
Aquifer Porosity 35 Percent
Predominant Aquifer Clay Type Plastic Clay Type
Aquifer Clay Porosity 50 Percent
Minimum Aquifer Compressibility 3.59E-04 p::si'1
Maximum Agquifer Compressibility 6.89E-04 p::si'1
Minimum Clay Compressibility 1.79E-03 ;::si'1
Maximum Clay Compressibility 1.38E-02 ;::si'1
Minimum Elastic Specific Storage (S..) 3.87E-06 ftt
Maximum Elastic Specific Storage (Sq.) 2.47E-05 ft'
Minimum Inelastic Specific Storage (5.,) 3.87E-04 ftt
Maximum Inelastic Specific Storage (Ssi) 2.47E-03 ft
Total Weighted Risk for Well 6.72

0 (low risk) to 10 (high risk) *

Figure 2.6. Subsidence prediction tool Pecos Valley Aquifer input and calculated values for Tracking Number
417430 in the Submitted Drillers Report database.
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Water Level Prediction
2,500

2,450

2,400

2,350

2,300

2,250

Feet Mean Sea Level (ft)

2,200

2,150

2,100
2010 2020 2030 2040 2050 2060 2070
Year

= Predicted Water Level Preconsolidation Water Level == == |and Surface Aquifer Top — — — Aquifer Bottom

Figure 2.7. Subsidence prediction tool predicted water level chart based on the Current and Trend Water Levels to
Use for Predictions for Tracking Number 417430 in the Submitted Drillers Report database.
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Drawdown and Subsidence Prediction
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Figure 2.8. Subsidence prediction tool predicted drawdown and potential subsidence chart based on the Current

and Trend Water Levels to Use for Predictions for Tracking Number 417430 in the Submitted Drillers
Report database.
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Water Level Prediction
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= Predicted Water Level Preconsolidation Water Level == == |and Surface Aquifer Top — — — Aquifer Bottom

Figure 2.9. Subsidence prediction tool predicted water level chart based on the Base and Future Water Levels to Use
for Predictions for Tracking Number 417430 in the Submitted Drillers Report database.
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Drawdown and Subsidence Prediction
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Figure 2.10. Subsidence prediction tool predicted drawdown and potential subsidence chart based on the Base and
Future Water Levels to Use for Predictions for Tracking Number 417430 in the Submitted Drillers
Report database.
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Table 2.1.  Excerpt of the subsidence prediction tool table of predicted water level, drawdown, and potential
subsidence for Tracking Number 417430 in the Submitted Drillers Report database.
Water Level and Subsidence Estimates based on Aquifer Trend
Year Water Level (ft) Draw.down compared to Miniml,!m Predicted Maximt_:m Predicted
Starting Water Level (ft) Subsidence (ft) Subsidence (ft)
2010 2,467 0.00 0.30 1.90
2011 2,467 0.27 0.30 1.92
2012 2,466 0.53 0.30 1.94
2013 2,466 0.80 0.31 1.96
2014 2,466 1.06 0.31 1.99
2015 2,466 1.33 0.31 2.01
2016 2,465 1.60 0.32 2.03
2017 2,465 1.86 0.32 2.05
2018 2,465 2.13 0.32 2.07
2019 2,465 2.39 0.33 2.09
2020 2,464 2.66 0.33 2.12
2021 2,464 2.93 0.33 2.14
2022 2,464 3.19 0.34 2.16
2023 2,464 3.46 0.34 2.18
2024 2,463 3.72 0.34 2.20
2025 2,463 3.99 0.35 2.23
2026 2,463 4.26 0.35 2.25
2027 2,462 4.52 0.36 2.27
2028 2,462 4.79 0.36 2.29
2029 2,462 5.05 0.36 2.31
2030 2,462 5.32 0.37 2.33
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Drawdown and Subsidence Prediction
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Figure 2.11. Subsidence prediction tool predicted drawdown and potential subsidence chart based on the Base and
Future Water Levels to Use for Predictions for Tracking Number 417430 in the Submitted Drillers
Report database with manual modifications to the predicted water levels.
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